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1. About Simcenter X Advanced
What is Simcenter X Advanced?

Simcenter X Advanced is a flexible, cloud-powered multi-domain collection of simulation products.

Simcenter X Advanced provides the following benefits:

Simplified access and management

• Utilize cloud-centralized license management

• Download, install, and update your simulation products with the Siemens Software Center

• Access your simulation tools from anywhere with an internet connection, with limited offline capabilities

Flexible licensing and resource optimization

• Share Simcenter X Tokens across multiple solvers and simulation products

Enhanced collaboration and productivity

• Work collaboratively on simulation projects through built-in data management

• Share models, results, and insights across engineering teams

Intelligent assistance

• Access help through an integrated AI-powered chat assistant

• Quickly find answers to technical questions and optimize your workflow

Simcenter X Advanced licenses

Your Simcenter X Advanced license is a named-user license supporting the applications listed below.

Simcenter X Advanced applications

Application Application specific documentation and support Named-user add-ons

Simcenter Femap Simcenter FEMAP

Simcenter X Advanced licenses
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Simcenter X Advanced applications (continued)

Application Application specific documentation and support Named-user add-ons

• Nastran

• Response Dynamics

• Thermal

Simcenter 3D

• Nastran

• Motion

• Multiphysics Thermal

• Harmonic BEM

• Durability & Response

• Dynamics solvers

Simcenter 3D

Simcenter STAR-CCM+

• Mixed precision

• Double precision
variants

Simcenter STAR-CCM+

Simcenter Amesim Simcenter AMESIM • Simcenter Amesim
Client for Git

• Simcenter Amesim
FMI Export

• Simcenter Amesim
Standalone FMI
Export

Simcenter HEEDS HEEDS

In addition to the named-user license and named-user add-on product licenses, you need to purchase
bundles of Simcenter X Tokens to use the simulation solvers included in the applications above. Simcenter
X Tokens are also needed for specific add-on features. For a list of token counts required for the various
add-on features and solvers, download the spreadsheet available here.

Simcenter X Advanced licenses
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Siemens Software Center

Siemens Software Center allows you to download, install, and activate your purchased software. You can
also update your installed software to newer versions as they become available.

Your welcome email contains a link to the Siemens Software Center web page. From here, you can
download and install Siemens Software Center by clicking the download link.

The software displayed in Siemens Software Center depends on the licenses your company has with
Siemens and which applications your Enterprise Cloud Account (ECA) admin has assigned you to. These
entitlements are associated with the login information you provide. When you open Siemens Software
Center, it prompts you to enter your login information.

Once you are logged in, your licensed software is displayed. You can then manage your software as
needed, including uninstalling it if necessary.

Download and install Simcenter X Advanced applications

Prerequisites

Your administrator must add you as a Simcenter X Advanced user so that you receive a welcome email
with instructions to download and install Siemens Software Center.

Procedure

1. In the welcome email, click the link provided and sign in with your Siemens Webkey account.

If you do not have a Webkey account, you can select a link on the sign in page to create a new
account.

2. Download and install Siemens Software Center.

Siemens Software Center
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If you are entitled to more than one Enterprise Cloud Account (ECA), you may be prompted to select
an ECA from a drop-down menu. You can contact your administrator to determine which ECA to
select.

3. Start Siemens Software Center .

If you are not signed in, you are prompted to sign in using your Webkey credentials and select your
account.

4. In the Siemens Software Center window, select the My Products tab.

5. (Optional) Next to the Install button for your Simcenter X Advanced application, click ( ) to
change install or download options.

For more information about Siemens Software Center options, click Help .

6. Click Install to download and install your Simcenter X Advanced application.

Launching a Simcenter X Advanced Application

You can launch the graphical user interface (GUI) of a Simcenter X Advanced application directly from
Siemens Software Center. When you launch the GUI, you must login with your Siemens account to
authenticate as a named user.

On Linux machines, before you launch a Simcenter X Advanced application, make sure that the following
are installed:

• xdg-open command – required for opening files, directories, and URLs; available through the xdg-utils
package.

• xcb-cursor library – required for handling cursor images and related operations.

To launch a Simcenter X Advanced application:

Procedure

1. Within Siemens Software Center, in the My Products tab, click Open next to the application.

You can also launch the application using one of its usual methods, for example, from the Start menu
on Windows.

The GUI launches and the login page opens in your web browser.

2. Authenticate on the Siemens authentication server:

a. On the login page, sign in with your Siemens Webkey email, then click Continue.

b. Select an identity provider, such as Siemens Webkey, then click Continue.

c. If your site is entitled to more than one ECA, select your ECA ID, then click Continue.

Launching a Simcenter X Advanced Application
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3. After successful authentication, close the login page in your web browser and return to the GUI of the
application.

Note
Your GUI login remains active for 12 hours. After 12 hours, you are automatically logged out from
all your GUI sessions and you must login again. For more information, see Authentication and
Secure Identifiers.

4. In the upper right corner of the application window, click your user avatar.

The user profile popup provides the following information:

• User credentials.

• Manage Install—a link to Siemens Software Center to manage the installation, such as updating
or uninstalling the application.

• Manage Secure Identifier—a link to the Secure Identifier Manager, which allows you to install,
update, or delete your secure ID. For more information, see Authentication and Secure
Identifiers.

• Log out and close/Log in—ends/starts your Simcenter X Advanced session.

Note
A warning sign on your profile icon indicates that the application cannot connect to the Siemens
cloud license server and is therefore operating in offline mode.

5. To end your session, in the user profile popup, click Log out and close.

Logging out also ensures that tokens that are reserved for your session are added back to the token
pool of your company and are available to other users.

Launching a Simcenter X Advanced Application
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Device Policy and Entitlement Transfer

Simcenter products running under the Simcenter X Advanced licensing scheme are governed by a Device
Policy. This policy defines the number of machines on which you can launch concurrent interactive desktop
sessions for each product.

A concurrent interactive desktop sessions means an active instance of the software product running on a
machine that you are directly interacting with. The Device Policy doesn't limit the number of interactive
sessions; it limits the number of machines on which you can launch interactive sessions. On a given
machine, you can launch as many interactive desktop sessions as you wish (within the limits of the
machine's resources).

Device Policy

Key points about the device policy are:
• The policy applies to interactive desktop sessions only. Batch sessions are not governed by this policy

(although you must deploy your secure ID on any remote machines on which you intend to run batch
sessions).

• Limits vary by product. Currently, the limits are as given in the following table:
Device Policy Limits

Application Device Policy Limit

Simcenter STAR-CCM+ 1

Simcenter HEEDS 3

Simcenter 3D 1

Simcenter Femap 1

Simcenter Amesim 1

Device Policy = 1
Allows you to launch multiple interactive desktop sessions of the product on a single machine. For
example, if you are using Simcenter STAR-CCM+, you can open several instances of the interactive
client on your primary workstation, but you cannot simultaneously open it on a remote Linux
machine.

Device Policy = 3
Allows you to launch concurrent interactive desktop sessions of the product on up to 3 different
machines simultaneously. For example, you could use Simcenter HEEDS on three different Windows
machines at the same time, and have multiple instances of the product running on each of those
machines.

Named User Entitlement Transfer

You can close an interactive session on one machine and open a new interactive session on another
machine. No specific steps are required in order to achieve this entitlement transfer — but if the Device

Device Policy and Entitlement Transfer
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Policy is exceeded, an entitlement transfer dialog appears asking if you wish to relinquish the entitlement
on the original machine.

Chat

Chat is an embedded, conversational user interface that lets you use natural language to query the official
online help documentation from your Simcenter X Advanced application.

You can use Chat to ask questions about commands, workflows, and applications. After you submit your
question, the chat:

• Searches the official help.

• Returns an AI-generated response, based on the resources.

• Provides clickable links to the applicable topics in the online help.

• Provides a list of related, AI-generated questions that you can query using the chat.

Warning
AI may hallucinate, which means that it may generate and present incorrect or misleading information
as fact.

When using AI-generated material, you should always verify the accuracy of the content using the
provided sources and your professional discernment.

The user interface

To activate Chat in the current session of your Simcenter X product, click Chat  in the top right
corner of the window. Typically, the chat window appears on the right side of the graphics window, but
you can move the window as desired.

Chat
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# Component Description

1 Submitted question Displays the question you
submitted.

2 Answer Displays the answer to
your question and the
referenced version of the help
documentation.

3 Good Response 

Bad Response 

Reserved for future capability.

3
Copy

Lets you copy the provided
answer.

4 Sources Displays a list of references that
are used in the given answer.

Each item in this list points to a
topic in the Help.

5 Related Displays a list of questions
that are related to the current
conversation.

You can click a question to find
more information.

6 New Chat Lets you start a new
conversation.

7 Prompt text box Lets you type your question.

You can enter up to 2000
characters in this text box.

Asking Chat a question

When asking a question in Chat, use best practices for prompt engineering.

• Use natural language.

Phrase each question as if you are asking a question to a colleague.

Chat
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Example

Instead of... Ask this..

Magnet orientation How do I assign orientation to a magnet?

• Be specific and provide context.

Example

Instead of... Ask this..

How do I run a parametric study? How do I run a parametric study in Design Space
Explorer?

• Verify the answer with the provided sources and your professional discernment.

Note
Chat is trained on English-language documentation. If you submit a question in a different language,
the AI will translate both your question and its response. Please note that this translation process may
introduce some inaccuracies.

Source documentation

Chat determines the product version of the Simcenter X Advanced application (such as Simcenter 3D,
Simcenter HEEDS, Simcenter STAR-CCM+, etc) that you are using. When you submit a question, the chat
references the official online Help for that application and version. The reply to your question specifies the
version of the documentation the chat referenced.

Chat

Simcenter X Advanced Onboarding Guide 1-9
Unpublished work. © 2025 Siemens



Chat

1-10 Simcenter X Advanced Onboarding Guide
Unpublished work. © 2025 Siemens



2. Built-in data management

Each Simcenter X Advanced user is automatically assigned a storage quota of 25GB in which to store data
on the cloud. You can use the Teamcenter Simulation Desktop application to perform daily activities such
as reviewing tasks and uploading and downloading files.

You can install the Teamcenter Simulation Desktop application using Siemens Software Center.

View and download recent files

View assigned tasks and the recent files you have worked on and download those files.

Procedure

1. To view tasks assigned to you, in Teamcenter Simulation Desktop, click the Home tab. Hover over the
appropriate task and click Open to view the task in a window embedded with the Active Workspace
user interface. You can complete the required task in the Overview tab of the viewer.

2. To view the recent files you have worked on, click the Home tab. Hover over the appropriate file and
click Open to view the selected file in the Active Workspace user interface.

3. To download files, click the Data tab.

a. Select the file, and click Download.

b. To download multiple files, press CTRL on your keyboard, select multiple files, and click
Download All.

4. To navigate quickly to the location where the file was downloaded, click the Go to Files hyperlink.

Upload files

Upload files to Simcenter X built-in data management.

Procedure

1. To upload files, click the Transfers tab.

2. Drag and drop the files you want to upload.

View and download recent files
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When you drag and drop files to upload, you do not need to know the name of the file upload rule.
The system recommends the appropriate domain, internally evaluates the domain, selects the correct
upload rule, and uploads the file.

CAE objects and their subclasses are categorized into a specific simulation domain based on the
upload rules and the files being uploaded. The system automatically selects the best domain. You
can override the selected domain. The system shows only the CAE objects that are stored within the
specified simulation domain when you upload files.

Application Teamcenter Domain

Simcenter Femap 3D simulation

Simcenter 3D

Simcenter STAR-CCM+

Simcenter Amesim Systems simulation

Simcenter HEEDS Multidisciplinary design analysis and
optimization

3. Select the target object recommended by the system. If it is not available, click the New button to
create a new target object.

4. Click Upload to upload the files.

5. (Optional) To verify if the files have been uploaded correctly, select the Data tab, select the recent file
you have uploaded, and click the Item Revision link.
The system displays the viewer with the Active Workspace user interface. You can view the uploaded
files under the appropriate object created in step 3.

6. (Optional) To verify if the object has any related objects, click the View Traceability link.

Results

To view AppData and log files, browse to the respective directory depending on the operating system:

• ◦ Windows:

%APPDATA%\teamcenter-simulation-app

◦ Linux:

$HOME/.config/teamcenter-simulation-app

Upload files
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3. Product-Specific Guidelines
Some products to which a Simcenter X Advanced license applies require you to observe specific guidelines
in launching the product or using some of its features.

Setting Up and Running a Simcenter STAR-CCM+ Simulation

In Simcenter STAR-CCM+, to use cloud licensing for your simulations, you must specify your cloud
entitlement.

The following workflow focuses on the specific aspects of cloud licensing in Simcenter STAR-CCM+. For
more general information, see the Simcenter STAR-CCM+ User Guide.

Note
If you want to run a simulation on a remote machine or a compute cluster, make sure that your Secure
ID for Simcenter STAR-CCM+ is installed on the remote machine or on the head node of the cluster,
respectively, see Managing your Secure ID—Common Scenarios.

To set up and run a Simcenter STAR-CCM+ simulation using cloud licensing:

Procedure

1. Launch Simcenter STAR-CCM+ using the following steps:

a. Create an environment variable on your machine. For example, on Windows:

i. Press the Windows+R key and enter sysdm.cpl in the Run dialog box. Press Enter.

ii. In the System Properties > Advanced tab, select Environment Variables.

iii. In the Environment Variables dialog box, navigate to System variables and select New.

iv. In the New System Variable dialog box, enter the following:

Variable Name CCM_LICENSE_OPTION7

Variable Value 1

b. Within Siemens Software Center, in the My Products tab, click Open next to the application.

Alternatively, you can launch the GUI using one of the following methods:
• On Windows, click the Simcenter STAR-CCM+ entry in the Start menu, assuming you did not

change any of the defaults during the installation

• On Windows or Linux, from the command prompt, enter the Simcenter STAR-CCM+
command.

Setting Up and Running a Simcenter STAR-CCM+ Simulation
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Example for Linux:

% [INSTALL_DIR]/STAR-CCM+20.06.2506.002/star/bin/starccm+ &

where [INSTALL_DIR] is the path to the installation directory.

Note
For correct functioning of cloud licensing for Nastran co-simulation, Nastran version
2506.5000 or later is required.

The GUI launches and the login page opens in your web browser.

2. Create or load a simulation, as required, using cloud licensing:

a. Select File > New or File > Load, respectively.

b. In the opening dialog, set Simulation License to one of the following options, depending on
your cloud entitlement:

• Simcenter STAR-CCM+ Cloud Entitlement

• Simcenter STAR-CCM+ Cloud Unlimited Entitlement

c. Complete the dialog, then click OK.

3. Set up your simulation, then save the simulation to file.

4. Depending on whether you want to run the simulation from the GUI or from a batch client, do one of
the following:

Method Procedure

Running directly from the GUI In the Solution toolbar, click (Run).

Running from a batch client 1. Open a command prompt.

2. In the command line, call Simcenter STAR-
CCM+ using one of the following licensing
options:

• For Simcenter STAR-CCM+ Cloud
Entitlement: -license cloud

• For Simcenter STAR-CCM+ Cloud
Unlimited Entitlement: -license
unlimited

Example:

[STAR-CCM+_INSTALL_DIR]
\starccm+.bat -batch [WORKING_DIR]
\[SIMULATION].sim -license
unlimited [OPTIONS]

Setting Up and Running a Simcenter STAR-CCM+ Simulation
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Method Procedure

where:

• [STAR-CCM+_INSTALL_DIR] is the path
to the Simcenter STAR-CCM+ installation
directory.

• [WORKING_DIR] is the path to your working
directory.

• [SIMULATION] is the name of the simulation
file.

• [OPTIONS] are optional arguments, such as
for running the simulation in parallel or on a
remote host.

This command line applies on Windows. For
Linux, you must use forward slashes.

Setting Up and Running a Simcenter STAR-CCM+ Design Study

In Simcenter STAR-CCM+, to use cloud licensing for design studies with Design Manager, you must specify
your cloud entitlement and pass it to the design simulations.

The following workflow focuses on the specific aspects of cloud licensing for design studies with Design
Manager. For more general information, see Simcenter STAR-CCM+ User Guide: Design Manager.

Note
If you want to run a design study on a remote machine or a compute cluster, make sure that your
Secure ID for Simcenter X CFD is installed on the remote machine or on the head node of the cluster,
respectively, see Managing your Secure ID—Common Scenarios.

To set up and run a design study using cloud licensing:

Procedure

1. Launch Simcenter STAR-CCM+ as described in Setting Up and Running a Simcenter STAR-CCM+
Simulation.

2. Create or load a design manager project, as required, using cloud licensing:

a. Select File > New or File > Load, respectively.

b. In the opening dialog, set the following properties:

• Term: Design Manager Project

Setting Up and Running a Simcenter STAR-CCM+ Design Study
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• Simulation License: Depending on your cloud entitlement, select one of the following
options:

◦ Simcenter STAR-CCM+ Cloud Entitlement

◦ Simcenter STAR-CCM+ Cloud Unlimited Entitlement

c. Complete the dialog, then click OK.

3. Setup your design studies as usual.

4. Pass your cloud entitlement to the design simulations:

a. Expand the Tools > Compute Resources node.

b. Set up the compute resource that you want to use, such as Default Direct, and add one of the
following options to Command Line Options:

• For Simcenter STAR-CCM+ Cloud Entitlement: -license cloud

• For Simcenter STAR-CCM+ Cloud Unlimited Entitlement: -license unlimited

5. Save the Design Manager project to file.

6. Depending on whether you want to run the design studies from the GUI or from a batch client, do
one of the following:

Method Procedure

Running directly from the GUI Run your design studies as usual.
Example:

To run all design studies sequentially, right-click
the Design Studies manager node and select
Run All Studies.

Running from a batch client 1. Open a command prompt.

2. In the command line, call Simcenter STAR-
CCM+ using one of the following licensing
options:

• For Simcenter STAR-CCM+ Cloud
Entitlement: -license cloud

• For Simcenter STAR-CCM+ Cloud
Unlimited Entitlement: -license
unlimited

[STAR-CCM+_INSTALL_DIR]
\starccm+.bat -batch run
[PROJECT_ROOT_DIR]\[PROJECT].dmprj
-license cloud [-passtodesign
"-license cloud"]

where:

Setting Up and Running a Simcenter STAR-CCM+ Design Study
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Method Procedure

• [STAR-CCM+_INSTALL_DIR] is the path
to the Simcenter STAR-CCM+ installation
directory.

• [PROJECT_ROOT_DIR] is the path to the
project root directory.

• [PROJECT] is the name of the Design
Manager project file.

• [-passtodesign <options>] allows you
to pass the licensing option for your
cloud entitlement to the design simulations.
Passing the licensing option directly from
the command line can be useful if you do
not want to save them within your Design
Manager project file. You can omit this option
if you specified the licensing option for your
cloud entitlement in Step 4.

This command line applies on Windows. For
Linux, you must use forward slashes.

Launching Simcenter Amesim

Simcenter Amesim can be downloaded and installed either from Support Center or from Siemens Software
Center.

From Siemens Software Center

When you install Simcenter Amesim from Siemens Software Center, cloud mode is automatically enabled.

Note
To disable cloud mode after an installation of Simcenter Amesim from Siemens Software
Center, delete the following file or the comment out the line where the environment variable
SALT_LICENSING_TYPE is set.

In Windows: “%APPDATA%\Simcenter\AMESim\2025.2\AMEUserCustomization.bat”

In Linux: “$HOME/Simcenter/AMESim/AMEUserCustomization.sh”

Launching Simcenter Amesim
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From Support Center

From Support Center, cloud mode is not automatically activated. To activate cloud mode, set the
system environment variable SALT_LICENSING_TYPE=cloud. You can create a batch file that sets this
environment variable and then launches Simcenter Amesim.

Note
Cloud mode is supported from Simcenter Amesim 2511 onward.

Systems simulation with Simcenter X Advanced

With Simcenter Amesim, the Simcenter X Advanced tier provides a comprehensive suite of powerful
features, ready to enhance your simulation workflows. For a detailed breakdown of all capabilities,
please consult the Siemens SW Simcenter X Advanced Licensing Fact Sheet document available from your
Siemens DISW representative.

Comprehensive Library Access

The Simcenter X Advanced tier grants you access to all available Systems libraries. Your core offering
includes a robust multi-physics package with 20 libraries. For specialized needs, you can access and
integrate additional libraries into your path list by utilizing Simcenter X Tokens.

Seamless Simulation Workflow

The process for running your simulations locally using cloud licensing remains intuitive and consistent:

1. Navigate to the Simulation tab.

2. Click the Run simulation button.

3. Simcenter Amesim automatically verifies that you have sufficient Simcenter X Tokens for the task

Systems simulation with Simcenter X Advanced
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Running any Systems simulation with the core solver requires 40 Simcenter X Tokens. These tokens are
automatically returned to your pool upon successful completion of the simulation, ensuring efficient use of
your resources.

Accelerate with Parallel Processing

Cloud licensing comes with native support for parallel processing, empowering you to run multiple
simulations in parallel and significantly speed up your analysis. Token consumption for parallel processing
scales linearly:

• For each parallel process initiated, 40 Simcenter X Tokens are consumed.

• Therefore, if you run 'n' parallel processes, the total token cost for the duration of that simulation is
n*40.

Running Simulations on HPC Machines (Remote Linux)

For demanding simulations, you can leverage the power of High-Performance Computing (HPC) clusters.
To get started running your Simcenter Amesim studies or batches on a remote Linux HPC machine:

1. HPC Mode Configuration: Ensure that HPC mode is activated and correctly configured within the
parallel processing section of your locally installed Simcenter Amesim. Detailed setup instructions can
be found in the HPC section of the documentation of Simcenter Amesim.

Systems simulation with Simcenter X Advanced
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2. Environment Variable: On your HPC machine, the following environment variable must be set in
your .bash_profile file to enable cloud licensing:

• export SALT_LICENSING_TYPE=cloud

3. Simcenter Amesim Version: Your HPC Cluster must be running Simcenter Amesim 2511 or a more
recent version.

4. Secure ID: Install a Secure ID using the Manage Secure Identifier tool. This tool is accessible from your
user avatar within your local Simcenter Amesim. For more guidance, see Authentication and Secure
Identifiers.

Extend Your Capabilities with Simcenter X Advanced Named-User Add-ons

Simcenter X Advanced offers specialized add-ons, each requiring a specific Named User License. These
add-ons provide powerful functionalities for advanced use cases:

Simcenter Systems Simulation Client for Git: This addon requires a specific installation available from
either the support center or the Siemens Software Center. It allows you to share/upload/download
Simcenter Amesim models, libraries of component models, architectures, simulation templates on/from
a git-based server, supporting a fine-grained development cycle by versioning and branching.

FMU Export Add-on: This feature allows you to export your Simcenter Amesim models as Model Exchange
or Co-Simulation Functional Mock-up Units (FMUs). To utilize these exported FMUs, you need a Simcenter
Amesim license (either cloud or on-premises). By means of these FMUs, you can integrate detailed
Simcenter Amesim models into other simulation environments.

Standalone FMU Export Add-on: This advanced add-on empowers you to generate license-free FMUs
directly from Simcenter Amesim. This method means the exported FMU can be run independently without
requiring a Simcenter Amesim license, making it appropriate for sharing models with partners or deploying
them in environments where a full Simcenter Amesim license is not available.

Note
To use the Standalone FMU Export Add-on, you must first have the FMU Export Add-on as a mandatory
prerequisite.

License options for Simcenter 3D

When you use the Siemens Software Center to install Simcenter 3D, cloud mode is automatically enabled.
However, to start solver runs from a command line you must first set the system environment variable
SPLM_LICENSE_SERVER=cloud.

License options for Simcenter 3D
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Switching to a node-locked license file or a license server

To disable cloud mode after an installation of Simcenter 3D, change the following files.

• In the Nastran.rcf file, comment out or delete the line auth=cloud.

• In the ugii_env.master file, comment out or delete the line export SALT_LICENSING_TYPE=cloud.

• Set the system environment variable SPLM_LICENSE_SERVER to point to the license location.

License options for Simcenter HEEDS

When you use the Siemens Software Center to install Simcenter HEEDS, it is configured to run with
cloud-enabled, named user licensing.

You can change the licensing mode used by the product with either of the following steps.

• From the Windows Start menu, select the Set license command installed with Simcenter HEEDS.

• From a command line, run: heedsmdo.exe -SetLicense.

License options for Simcenter HEEDS
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License options for Simcenter HEEDS
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4. Authentication and Secure Identifiers

User authentication is essential for ensuring the security, integrity, and compliance of cloud-based
applications. For this reason, Simcenter X Advanced provides a robust authentication framework for user
identity verification and access control.

Authentication Modes

The authentication framework for Simcenter X Advanced cloud-enabled applications involves the following
authentication modes:

Interactive authentication
With interactive authentication, you authenticate via a web browser connection to the Siemens
Authentication Server. You login using either your Siemens ID (Webkey) or an alternative identity
provider (IdP), as set up by your Enterprise Cloud Account (ECA) Admin in the Siemens Xcelerator Admin
Console.

Non-interactive authentication
With non-interactive authentication, you authenticate via a Secure Identifier (ID) on your local disk,
where a secret authentication key is encrypted and stored. Note that for each user, there is one Secure
ID per Simcenter X Advanced application. The Secure Identifier is connected to your Enterprise Cloud
Account (ECA).

Session Management

To deliver a seamless and secure authentication process, sessions of Simcenter X cloud-enabled
applications combine interactive and non-interactive authentication.

The graphical user interface (GUI) of a Simcenter X Advanced application uses interactive authentication.
When you launch the GUI, you are prompted for interactive authentication. Then, the Siemens
Authentication Server validates your login credentials, generates an access token that contains identity
and role information, and returns the token to the Simcenter X Advanced application.

Your access token to the Siemens Authentication Server remains active for 12 hours. Any GUI session
that you launch during this time does not request your login. When the 12-hour period ends, you are
automatically logged out from all your GUI sessions and you must authenticate interactively again.

This approach of periodic re-authentication enhances security by limiting the duration of access.

Example:
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Non-interactive authentication via a Secure ID is used for authentication requests of various backend
processes, such as solvers. When you first launch the GUI of a Simcenter X Advanced application and
authenticate interactively, the product-specific Secure ID is automatically installed in the home directory
on your local machine. When a backend process requests authentication, the Simcenter X Advanced
application checks the Secure ID and, if the Secure ID is valid, processes the request.

Secure IDs have a 12-month validity, which makes them particularly useful for scenarios where continuous
access is needed, such as running processes that require long-term authentication without frequent
interruptions. When the Secure ID expires, you must revoke the Secure ID on the Siemens Authentication
Server and install a new Secure ID. For non-GUI enabled machines, such as Linux compute clusters, you
must install the Secure ID remotely.

Example:

Secure ID Management

Each Simcenter X Advanced application allows you to manage its product-specific Secure ID using a tool
called Simcenter X Secure ID Manager. You can use the Manage Secure Identifier command to open the
tool from each application, or you can launch it from within the installation directory associated with the
calling application. If you are using multiple Simcenter X Advanced applications, you must manage the
Secure ID for each application individually.

The Manage Secure Identifier tool allows you to:

• Install a Secure ID (on local machines and remote Linux machines)
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• Delete a Secure ID (on local machines and remote Linux machines)

• Revoke a Secure ID (on the Siemens Authentication Server)

Launch the Manage Secure Identifier Tool

You can launch the Manage Secure Identifier tool from your profile icon in the GUI of your Simcenter X
Advanced application or directly from its installation directory.

On Linux machines, before you launch the Manage Secure Identifier tool, make sure that the following are
installed:
• xdg-open command – required for opening files, directories, and URLs; available through the xdg-utils

package.

• xcb-cursor library – required for handling cursor images and related operations.

To launch the Manage Secure Identifier tool:

Procedure

1. Depending on how you want to launch Secure Identifier Manager, do one of the following:

Method Procedure

Launch from the GUI of the Simcenter X
Advanced application, such as Simcenter STAR-
CCM+.

1. In the title bar of the Simcenter X Advanced
application, click your profile icon.

2. In the profile menu, click Manage Secure
Identifier.

Launch directly from its installation directory.
With this method, you must have access to
the installation directory of the Simcenter
X Advanced application and administrator
privileges.

1. Open a command prompt
and navigate to the following
directory: [SimcenterXapp_installDir]/
sidtool_ui/0.6.0/ win64/bin where
[SimcenterXapp_installDir] is the
installation directory of the Simcenter X
application.

2. In the command prompt, enter the
following command:

SimcenterXSecureIDManager.exe 
--product [SimcenterX_prod]

Launch the Manage Secure Identifier Tool
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(continued)

Method Procedure

where [SimcenterX_prod] is one of the
following options, depending on your
Simcenter X Advanced application:

Simcenter
X Advanced
application [SimcenterX_prod]

Simcenter STAR-
CCM+

cfd

HEEDS mdao

Simcenter Femap mech

Simcenter 3D

Simcenter Amesim systems

2. If your last interactive authentication with the Siemens Authentication Server was more than 12
hours ago, you are prompted for interactive authentication in your web browser. After successful
authentication, the Manage Secure Identifier—[SimcenterX_prod] dialog appears, where you can
manage your Secure ID for the respective Simcenter X Advanced application.

Launch the Manage Secure Identifier Tool
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Managing your Secure ID—Common Scenarios

Simcenter X Advanced applications allow you to manage your Secure ID, including revoking an expired
Secure ID and installing a new one.

The following table lists common scenarios that require you to actively manage your Secure ID:

Scenario Procedure

Your Secure ID expires after 12 months. When your Secure ID expires after its 12-month
validity, you must revoke the Secure ID from the
Siemens Authentication Server and install a new
Secure ID.

Note
You are advised to update your Secure ID shortly
before its expiration date to avoid any periods
where your Secure ID is not valid.

To update an expired Secure ID:

1. Launch the Manage Secure Identifier Tool.
The Manage Secure Identifier dialog displays
the expiration date of your Secure ID.

2. Revoke the expired Secure ID on the Siemens
authentication server. See Revoking a Secure
ID.

3. (Optional) To clean up your machine, delete
the disabled Secure ID file. See Deleting a
Secure ID.

4. Install a new Secure ID. See Installing a
Secure ID. The 12-month validity period of
the new Secure ID file starts on the date of its
installation.

You want to run a Simcenter X Advanced
application remotely.

If you want to run a Simcenter X Advanced
application remotely, you must install your product-
specific Secure ID on the remote machine.

To install the Secure ID on the remote machine, do
one of the following, depending on the operating
system (OS) of the remote machine:

• For Linux: See Installing a Secure ID: Remote
Linux machine.

Managing your Secure ID—Common Scenarios
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Scenario Procedure

• For Windows: See Installing a Secure ID:
Remote Windows machine.

You want to run the Simcenter X Advanced
application on a compute cluster.

If you want to run a Simcenter X Advanced
application on a compute cluster, you must install
the product-specific Secure ID on the head node of
the cluster.

Note
For compute clusters, to make the Secure ID
accessible from all cluster nodes, the cluster must
provide a shared home directory. Additionally,
all cluster nodes must have outbound internet
access.

To install the Secure ID on the head node of the
cluster, do one of the following, depending on the
OS of your cluster:

• For Linux: See Installing a Secure ID: Remote
Linux machine.

• For Windows: See Installing a Secure ID:
Remote Windows machine.

A security breach occurred. If you suspect that your Secure ID or associated
credentials are compromised or exposed to
unauthorized individuals, you are strongly advised
to do the following:
1. Revoke the Secure ID on the Siemens

authentication server. See Revoking a Secure
ID.

2. Delete the disabled Secure ID files from your
local and remote machines. See Deleting a
Secure ID.

3. Install a new Secure ID on your local and
remote machines, as required. See Installing
a Secure ID.

Installing a Secure ID

When you first launch a Simcenter X Advanced application and authenticate interactively, a Secure ID is
automatically installed on your machine.

Installing a Secure ID
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However, some scenarios require that you manually install a Secure ID. See Managing your Secure ID—
Common Scenarios.

To install a Secure ID, use a procedure from the table below.

Target Location of Secure ID Procedure

Local machine (Windows or Linux) 1. Launch the Manage Secure Identifier Tool
on your local machine.

2. Within the Manage Secure Identifier dialog,
in the Local Machine group box, click Install
Secure ID.
Note
If Install Secure ID is disabled, a valid
Secure ID is already installed on your local
machine.

The Secure ID is installed in your home on
the local machine. A Success dialog appears
and informs you that your Secure Identifier
has been successfully created or loaded.

3. Click OK.

Remote Linux machine 1. Launch the Manage Secure Identifier Tool
on your local machine.

2. Within the Manage Secure Identifier dialog,
in the Remote Linux Machine group box,
click Install Secure ID.

The Install secure identifier on Remote
Machine dialog opens.

3. Set the following properties:

• Machine

• Port

• Username

• Password

• Private Key

4. Click Install.

Secure ID Manager connects to the remote
Linux machine using ssh and installs the
Secure ID in your home directory on the
remote machine. A Success dialog appears

Installing a Secure ID
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Target Location of Secure ID Procedure

and informs you that your Secure Identifier
has been successfully installed on the remote
machine.

5. Click OK, then Close.

Remote Windows machine The Manage Secure Identifier tool currently does
not support the installation of Secure IDs on
remote Windows machines. You are advised to
directly login to the Windows machine and install
the Secure ID locally.

Deleting a Secure ID

With the Manage Secure Identifier tool, you can delete a Secure ID from a specific machine (local or
remote).

To delete a Secure ID, use a procedure from the table below.

Location of Secure ID Procedure

Local Machine (Windows or Linux) 1. Launch the Manage Secure Identifier Tool.

2. Within the Manage Secure Identifier dialog,
in the Local Machine group box, click Delete
Secure ID.

Note
If Delete Secure ID is disabled, no Secure ID
is installed on your local machine.

The Secure ID file is removed from your home
directory.

A Success dialog appears and informs
you that your Secure Identifier has been
successfully deleted from the local machine.

3. Click OK, then Close.

Remote Linux Machine 1. Launch the Manage Secure Identifier Tool.

2. Within the Manage Secure Identifier dialog,
in the Remote Linux Machine group box,
click Delete Secure ID.

Deleting a Secure ID
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Location of Secure ID Procedure

The Delete secure identifier on Remote
Machine dialog opens.

3. Set the following properties:

• Machine

• Port

• Username

• Password

• Private Key

4. Click Delete.

Secure ID Manager connects to the remote
Linux machine using ssh and deletes the
Secure ID file from your home directory. A
Success dialog appears and informs you that
your Secure Identifier has been successfully
deleted from the remote machine.

5. Click OK, then Close.

Remote Windows machine The Manage Secure Identifier tool currently does
not support the deletion of Secure IDs on remote
Windows machines. You are advised to directly
login to the Windows machine and delete the
Secure ID locally.

Revoking a Secure ID

When you revoke a Secure ID, it is disabled on the Siemens authentication server and no longer valid for
authentication.

To revoke a Secure ID:

Procedure

1. Launch the Manage Secure Identifier Tool.

2. In the Manage Secure Identifier dialog, in the All Machines group box, click Revoke Secure ID on
Siemens Authentication Server.
A Warning dialog appears and informs you that your Secure ID will be revoked and will cease working
on all machines.

3. Click Proceed.

Revoking a Secure ID
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The Secure ID is disabled and no longer valid for authentication. The disabled Secure ID files remain
on your machines.

A Success dialog appears and informs you that your Secure ID has been successfully revoked.

4. Click OK.

5. (Optional) To clean up your machines, delete the disabled Secure ID files from your local and remote
machines. See Deleting a Secure ID.

6. Click Close.

If you are experiencing issues connecting the solver to cloud licensing, try deleting and regenerating the
Secure Identifier. This often resolves connectivity problems.

Revoking a Secure ID
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5. Simcenter X Advanced accounts and
licensing

When you purchase Simcenter X Advanced, an email that contains information to activate the cloud
account and add users is sent to an Enterprise Cloud Account (ECA) admin.

An administrator must assign a Simcenter X Advanced named-user license to a user to allow them to
download, install, and run their Simcenter X Advanced application.

Named-user add-ons

If you have also purchased named-user add-ons, an administrator must assign those add-on licenses to a
user after assigning a Simcenter X Advanced named-user license to them.

Tokenized add-ons

Simcenter X Advanced also offers tokenized add-ons. To use these add-ons, you need to purchase bundles
of Simcenter X Tokens based on the number of users and the add-on products and solvers they use.

The tokens you purchase become part of a common token pool. When a team member uses an add-on
product or solver, its token value is subtracted from the available pool. When a team member is finished
with the product or solver, that token value is added back to the pool.

Starting and exiting your Simcenter X Advanced application

When you start your Simcenter X Advanced application, you must select an account and specify your
credentials.

The Simcenter X Advanced session is associated to you, and your profile picture is displayed in the upper
right corner of the Simcenter X Advanced product window with the option to sign out.

Siemens Digital Industries Software recommends you use the Log Out option to exit an Simcenter X
Advanced session to ensure that Simcenter X Tokens are immediately added back to the token pool and are
available to other users.

Configuring your cloud account and adding users

Configuring your cloud account and adding users
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If you are an Enterprise Cloud Account (ECA) admin, you will receive a welcome email with a link to access
the Siemens Xcelerator Admin Console so that you can activate the cloud account and add Simcenter X
users.

For more information, you can refer to the Getting Started section of the Admin Console Documentation.

Configuring your cloud account and adding users
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